
@AIR USER’S MANUAL 
VERSION 4.0 

COPYRIGHT NOTICE 

The @Air software and manual are copyrighted and licensed for use by one user per copy 
purchased.  This manual and the software described in it are copyrighted with all rights 
reserved.  Under the copyright laws, this manual or the software may not be copied, in whole 
or part without written consent of Techware Engineering Applications, Inc.  Techware 
Engineering Applications, Inc. grants permission to the purchaser to make a limited number of 
copies of the add-in for backup purposes only, provided that the copies are not in use at the 
same time as the original.  Additional reproduction of the add-in is a violation of copyright law.  
Violators will be prosecuted to the fullest extent of the law. 

Copyright© 1995 - 2012 
Techware Engineering Applications, Inc. 

All rights reserved 
 

TRADEMARKS 

The following trademarks are used throughout this manual.  They are registered trademarks of 
the companies shown. 

Lotus®, and 1-2-3® are trademarks of Lotus Development Corporation. 

Excel®, Windows®, Visual C/C++® and Visual BASIC® are trademarks of  the Microsoft 
Corporation. 

Mathcad® is a trademark of MathSoft, Inc. 



 

 Table of Contents 

1.  INTRODUCTION .......................................................................................................... 1 
1.1  Overview ....................................................................................................................... 1 
1.2  32-Bit and 64-bit versions ............................................................................................. 2 
1.3  What’s New .................................................................................................................. 2 

2.  USING THE @AIR PROPERTY FUNCTIONS ............................................................. 4 
2.1  General Information ...................................................................................................... 4 
2.2  Description of @Air Functions ...................................................................................... 4 

2.2.1  Valid Operating Range ...................................................................................... 6 
2.2.2  Basic Unit Sets .................................................................................................. 6 
2.2.3  Wet or Dry Basis ................................................................................................ 7 
2.2.4  Alternate Moisture Parameters .......................................................................... 7 
2.2.5  Reference Conditions ........................................................................................ 8 

2.3  Using @Air from Excel ................................................................................................. 9 
2.3.1  Loading the @Air Functions into Excel (32-bit) .................................................. 9 
2.3.2  Loading the @Air Functions into Excel (64-bit) .................................................. 9 
2.3.3  Using the @Air Functions ................................................................................ 10 

2.4  Using @Air from 1-2-3 ................................................................................................ 10 
2.5  Using @Air from Mathcad .......................................................................................... 11 
2.6  Using @Air from Visual BASIC ................................................................................... 12 
2.7  Using @Air With Programming Languages ................................................................ 13 
2.8  Version and Serial Number ......................................................................................... 13 

3.  USING DESKTOP AIR ............................................................................................... 14 
3.1  Overview ..................................................................................................................... 14 
3.2  Basic Operation .......................................................................................................... 14 
3.3  Entering Data .............................................................................................................. 15 
3.4  Unit Selection ............................................................................................................. 16 
3.5  Calculating State Points .............................................................................................. 17 
3.6  Formatting Property Values ........................................................................................ 17 
3.7  Labeling and Storing State Points .............................................................................. 17 
3.8  Printing ....................................................................................................................... 18 
3.9  Saving And Opening Data Files .................................................................................. 18 



3.10 Advanced Features .................................................................................................... 19 
3.10.1  Expansion/Compression Tool .......................................................................... 19 
3.10.2  Heating/Cooling Tool ....................................................................................... 20 
3.10.3  Exchanging Data with Other Programs ............................................................ 21 

3.11 Getting Help ................................................................................................................ 21 
3.12 Error Messages .......................................................................................................... 21 
3.13 Exiting DeskTop Air .................................................................................................... 21 

4.  THEORETICAL BASIS OF @AIR FUNCTIONS ......................................................... 22 
4.1  Basis of Calculations .................................................................................................. 22 
4.2  Humidity Parameters .................................................................................................. 25 
4.3  Transport Properties ................................................................................................... 26 

5.  SPEED AND ACCURACY CHARACTERISTICS ....................................................... 29 
5.1  Speed of Calculations ................................................................................................. 29 
5.2  Accuracy of Calculations ............................................................................................ 29 

6.  REFERENCES ........................................................................................................... 38 

APPENDIX -  @AIR ERROR CODES 





Chapter 1 – Introduction Page 1 

1. INTRODUCTION 

1.1 OVERVIEW 

@Air is a software product that provides accurate thermodynamic, psychrometric and 
transport properties of moist air through functions contained in a Dynamic Link Library (DLL). 
The @Air package includes DeskTop Air, an interactive air property calculator and various 
add-ins, which allow the functions to be used as if they were built into 1-2-3 for Windows, 
Microsoft Excel and Mathcad.  In 1-2-3 and Excel, you can access the functions directly from 
within cell formulas.  Programmers can call the functions in the DLL directly from many 
Windows programming languages such as Microsoft's Visual Basic, Visual C++ and Access. 

The DLL provides a library of accurate functions, which are based on data published by the 
National Bureau of Standards (NBS) in 1955 (1).  The NBS data is also the basis of the 
formulations used to develop the tables published in the American Society of Heating, 
Refrigeration and Air-Conditioning (ASHRAE) Fundamentals, 1993.  All of the properties 
calculated by @Air are based on real gas properties, not perfect gas approximations.  As 
such, they include the effects of pressure and interactions caused by the mixing of water vapor 
and dry air components.  For details on the theory and accuracy of the functions, check the 
html version of the user’s manual. 

The psychrometric functions facilitate conversion among various moist air parameters such as 
absolute humidity, relative humidity, wet bulb temperature and degree of saturation.  The 
thermodynamic property functions provide forward and inverse relationships using specific 
volume, specific enthalpy and specific entropy.   The transport property functions provide 
specific heat, dynamic viscosity and thermal conductivity from pressure, temperature and 
humidity ratio.  Also included are several functions, which provide thermodynamic properties of 
water which are useful in calculations involving addition or removal of moisture from air 
streams. 

The @Air functions are valid over a temperature range from 180 °K, (-136 °F) to 2000 °K, 
(3140 °F) and at pressures up to 5.0 MPa, (725 psia).  The functions detect requests for 
calculations outside that range and return an error value. 

The Setup program and the installation instructions contained in the @Air package guide you 
through installing the files you'll need for the applications you expect to use.  Example files to 
help you get started will also be installed. 

The name, @Air, was created to signify that it contains @ functions that were compatible with 
Lotus 1-2-3, the dominant spreadsheet program several years ago.  Today, the @ symbol is 
most recognized as part of an internet e-mail address.  However, for continuity, we have 
retained the name @Air even though the current product supports a variety of Windows 
applications. 
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1.2 32-BIT AND 64-BIT VERSIONS 

The @Air package includes both 32-bit and 64-bit installation files.  The installation 
instructions you received with the @Air package will guide you through installing the files you'll 
need for the applications you expect to use.  Example files to help you get started will also be 
installed. 

1.3 WHAT’S NEW 

@Air 4.0 adds 64-bit versions of the TAir DLL, the DeskTop Air calculator and the Excel add-
in.  It also has converted all help files to compiled HTML format for compatibility with newer 
operating systems.   

@Air 3.2 does not install the help shortcut on the toolbar when using Excel 2007 or later in 
order to operate more reliably. 

@Air 3.1 adds a seventh unit set, METF, which is similar to the MET unit set but uses kg/cm2 
for pressure.  This version also improves the accuracy of the transport properties. 

@Air 3.0 adds many new features over the previous version, @Air 2.0.  These include the 
following: 

• Extends the temperature range upwards from 200 °C, (392 °F) to 2000 °K, (3140 °F).   

• Adds transport property functions:  

o AirPTWC, which calculates specific heat given pressure, temperature and 
humidity ratio. 

o AirPTWM, which calculates dynamic viscosity given pressure, temperature and 
humidity ratio. 

o AirPTWK, which calculates thermal conductivity given pressure, temperature and 
humidity ratio. 

• Includes DeskTop Air, an advanced air property calculator with many improved 
features over the previous air property calculator. 

• Adds four new unit sets, EngG using psig for pressure instead of psia, SIF, which uses 
the formal SI units, MPa for pressure instead of bar and °K for temperature, instead of 
°C, SIK using kPa instead of bar for pressure and MET using the calorie instead of the 
joule for energy. 

• Allows specific properties to be expressed on either a dry or wet basis. 

• Allows the humidity ratio parameter to be input alternately, as mole fraction or mass 
fraction. 

• Added new thermodynamic functions: 

o AirPTHs, which calculates saturated enthalpy given pressure and temperature. 
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o AirPHTs, which calculates saturation temperature for a given pressure and 
enthalpy. 

o AirWX, which calculates either the mole or mass fraction given the humidity ratio, 

o AirXW, which calculates the humidity ratio given either the mole or mass fraction. 

• Improved installation program that allows distribution over the web. 
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2. USING THE @AIR PROPERTY FUNCTIONS 

2.1 GENERAL INFORMATION 

All applications using the air property functions use the same set of functions.  In most 
applications, the functions are called by name.  In the DeskTop Air calculator, the appropriate 
functions are called automatically according to your on-screen selections. 

Each user of spreadsheets or programs you write using the air property functions, must have 
their own copy of @Air.  Spreadsheets and programs calling the functions must access the 
dynamic link libraries at run time.  Since these files will be called by many applications, they 
must be installed on the computer in either the Windows directory or preferably, in the 
Windows System directory.  Normally, the installation program will set this up for you 
automatically. 

In Excel, 1-2-3, Mathcad, Visual BASIC and your own Windows programs, the functions 
provided by @Air can be used within equations just like each application's built-in math 
functions.  The functions can even be nested.  Each function returns a single, floating point 
result.  The functions require up to three inputs and a unit set parameter to identify the state 
point.  Subsequent sections of this chapter describe the calling syntax and other 
considerations in using the functions within supported applications.   

2.2 DESCRIPTION OF @AIR FUNCTIONS 
All of the @Air functions, which are accessible to the user, are summarized in the table below.    

Function Input(s) Output    

Equations of State 
AirPTWV() Pressure, Temperature, H2O Content Specific Volume 
AirPVWT() Pressure, Volume, H2O Content Dry Bulb Temperature 
AirTVWP() Temperature, Volume, H2O Content Pressure 

Thermodynamic and Psychrometric Functions 
AirPTW() Pressure, Temperature Saturated Humidity Ratio 
AirPWD() Pressure, H2O Content Dew Point Temperature 
AirPTF() Pressure, Temperature Enhancement Factor 
AirPTRW() Pressure, Temperature, Relative Humidity H2O Content 
AirPTWR() Pressure, Temperature, H2O Content Relative Humidity 
AirPTWB() Pressure, Temperature, H2O Content Wet Bulb Temperature 
AirPTBW()  Pressure, Temperature, Wet Bulb H2O Content 
AirPBWT() Pressure, Wet Bulb, H2O Content Temperature 
AirPBRT() Pressure, Wet Bulb, Relative Humidity Temperature 
AirPTWU() Pressure, Temperature, H2O Content Degree of Saturation 
AirPTUW() Pressure, Temperature, Degree of Humidity Ratio 
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Saturation 
AirPTWH() Pressure, Temperature, H2O Content Specific Enthalpy 
AirPHWT() Pressure, Enthalpy, H2O Content Temperature 
AirPWHT() Pressure, H2O Content, Enthalpy Temperature 
AirPTHs() Pressure, Temperature Saturated Enthalpy 
AirPHTs Pressure, Enthalpy Saturated Temp 
AirPTWS() Pressure, Temperature, H2O Content Specific Entropy 
AirPSWT() Pressure, Entropy, H2O Content Temperature 
AirPWST() Pressure, H2O Content, Entropy Temperature 

Transport Property Functions 
AirPTWC() Pressure, Temperature, H2O Content Specific Heat 
AirPTWM() Pressure, Temperature, H2O Content Dynamic Viscosity 
AirPTWK() Pressure, Temperature, H2O Content Thermal Conduct 

Vapor and Liquid Water Property Function 
AirVapTP() Water Vapor Temperature Sat Pressure 
AirVapPT() Water Vapor Pressure Sat Temperature. 
AirCondPTH() Pressure, Water Temperature Specific Enthalpy 
AirCondPTS() Pressure, Water Temperature Specific Entropy 

Miscellaneous Functions 
AirWX() Humidity Ratio Mass or Mole Fraction 
AirXW() Mass or Mole Fraction Humidity Ratio 
AirVer() None Version/serial no. 

Theoretically, an air property state point can be uniquely identified by specifying any two 
thermodynamic properties and a measure of the ratio of water vapor to dry air.  In most 
practical applications, pressure is one of the known variables.  Therefore, most of the functions 
described above assume that pressure is one of the known variables.  If this is not the case, 
one of the equations of state may be used to obtain the pressure.   

You may be familiar with psychrometric charts or air property tables in which pressure is not 
one of the variables.  There are a couple of reasons for this.  Typically, psychrometric charts 
and ASHRAE tables are valid only at atmospheric pressure.  In these cases, the pressure 
variable is implied as standard atmospheric pressure.  In other references, air is sometimes 
treated as a perfect gas in which properties such as enthalpy, entropy and specific heat are not 
dependent upon pressure.  Treating air as a perfect gas produces only rough approximations 
to the actual properties.  The perfect gas approximations are reasonable at low pressures but 
increase in error as the pressure is increased.  The formulations used in @Air are based on 
real gas properties and include the effects of pressure and the mixing of air and water vapor.  
Refer to section 4 for more information about the model used and its accuracy. 

The property “Moisture Content” refers to the humidity ratio by default. You can change it to 
refer to mole fraction of water vapor by adding a “C” to the unit set argument or mass fraction 
by adding an “M”.  If some other measure of moisture is known such as Relative Humidity, Wet 
Bulb Temperature, Degree of Saturation or Dew Point Temperature, use one of the functions 
provided to obtain the Moisture Content.  As long as the state point is defined, you should be 
able to find the property you need in most cases, by using various combinations of the 
functions.   
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A function, AirPTW is provided to obtain the saturated moisture content for a known pressure 
and temperature.  The Dry Bulb Temperature at saturation is synonymous with the Dew Point 
Temperature.  Therefore, this function can be used with a pressure and the Dew Point 
Temperature to obtain the moisture content.  The inverse of this function is AirPWD, which 
returns the Dew Point or Dry Bulb Temperature at which the air becomes saturated based on 
the level of water vapor specified. 

The function AirPTHs calculates the enthalpy of moist air saturated with water at a given 
pressure and temperature.  It is equivalent to calling the AirPTW function to get the saturated 
moisture content and then calling the AirPTWH function with the calculated moisture content. 

The function AirPHTs is used to analyze a process of simultaneous heating and humidification 
or cooling and evaporation when the output stream is in a saturated state. 

2.2.1 Valid Operating Range 
The @Air functions are valid over a temperature range from 180 °K, (-136 °F) to 2000 °K, 
(3140 °F) and at pressures up to 5.0 MPa, (725 psia).  The functions detect requests for 
calculations outside that range and return an error value. 

2.2.2 Basic Unit Sets 

Input to all the functions and all results can be in any of the available unit sets.  

The table below summarizes the units used for each unit set. 

 English SI English 
Gauge 

SI Formal SI kPa Metric Metric 
Formal 

Unit Set Number 0 1 2 3 4 5 6 
Unit Set Name "ENG" "SI" “ENGG” “SIF” "SIK" "MET" “METF” 
Temperature °F °C °F °K °C °C °C
Pressure psia Bar psig MPa kPa bar kg/cm2 
Entropy Btu/lbm/ °F kJ/kg/°C Btu/lbm/°F kJ/kg/°C kJ/kg/°C kcal/kg/°C kcal/kg/°C 
Enthalpy Btu/lbm kJ/kg Btu/lbm kJ/kg kJ/kg kcal/kg kcal/kg 
Specific Volume ft3/lbm m3/kg ft3/lbm m3/kg m3/kg m3/kg m3/kg 
Specific Heat Btu/lbm/°F kJ/kg/°C Btu/lbm/°F kJ/kg/ °K kJ/kg/°C kcal/kg/°C kcal/kg/°C 
Viscosity lbm/ft-hr Centipoise lbm/ft-hr Pa-sec Centipoise Centipoise Centipoise
Conductivity Btu/hr/Ft/°F watt/m/°C Btu/hr/Ft/°F watt/m/°K watt/m/°C watt/m/°C watt/m/°K 
Humidity Ratio Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim 
Relative Humidity Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim 
Degree of Sat. Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim Non-Dim 

 

@Air lets the user select the desired unit set with each function call by the use of an extra 
function argument, the unit set parameter.  The unit set parameter selects basic units, Eng, SI, 
etc. and optional unit set modifiers.  The air property functions within the function library 
contain the conversion factors for the basic unit sets and the set modifiers. 

When calling air property functions from Visual Basic or any other Windows programming 
language, the unit set parameter is required and must be an integer value.   

Additional flexibility in entering the unit set parameter is available when using the air property 
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add-in functions from Excel or 1-2-3. The spreadsheet add-ins allow the unit set parameter to 
be entered either as a character string or an integer value.  For most users, the character 
string method is preferable because the characters representing the unit sets and their options 
are mnemonic.  For Mathcad, the unit set can only be entered as a number, however, you can 
achieve the same effect by defining mnemonics for the base unit sets and the options right on 
your Mathcad worksheet   

2.2.3 Wet or Dry Basis 

All mass-dependent properties (specific volume, enthalpy, entropy, specific heat, viscosity and 
conductivity) can be based on either a dry or wet basis.  The default for all basic unit sets 
expresses the properties per mass of dry air.  This is consistent with ASHRAE conventions 
and is quite useful when dealing with processes that involve evaporation or condensation of 
water vapor.   

In some cases, you may wish to express these properties on a wet basis, that is, per mass of 
wet air (dry air plus water vapor).  You can accomplish this by adding the letter “W” to the unit 
set name or adding 16 to the unit set number.  Remember that the choice of wet or dry basis 
affects both input and output properties. 

For example in Excel, you can calculate the enthalpy of moist air on a wet basis at a pressure 
of 15 psia, a temperature of 150 °F and a humidity ratio of 0.015 as follows: 

 =AirPTWH(15,150,0.015,”EngW”)  

2.2.4 Alternate Moisture Parameters 

The amount of moisture in the air can be expressed in several ways, including humidity ratio, 
mole fraction and mass fraction.  Humidity ratio is defined as the ratio of the mass of water 
vapor to the mass of dry air.  This method of expressing moisture is particularly useful when 
dealing with evaporation of condensation because the flow of dry air remains constant with 
either of these processes.  Mole fraction, which is equivalent to volume fraction, is the ratio of 
the moles of water vapor to the total moles of water vapor plus dry air.  Mass fraction is the 
ratio of the mass of water vapor to the mass of water vapor plus the mass of dry air. 

The moisture content parameter W, refers to humidity ratio by default.  This is a natural choice 
if properties are expressed on a dry basis.  If you choose to express properties on a wet basis, 
you may find it more convenient to express the moisture parameter as a mole or mass fraction.  
You can substitute mole fraction wherever humidity ratio is used, by adding a “C” to the unit set 
name or 32 to the unit set number.  Similarly, you may substitute mass fraction of water vapor 
wherever Humidity Ratio is used, by adding an “M” to the unit set name or 64 to the unit set 
number.   If “CM” is added to the unit set name or 96 is added to the unit set number, the mass 
fraction alternative is selected. 

For example in Excel, you can calculate the enthalpy of moist air at a pressure of 5 psig, a 
temperature of 180 °F and a moisture content of 1.5% by volume as follows: 

 =AirPTWH(5,180,0.015,”EngGC”)  
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2.2.5 Reference Conditions 

Enthalpy and entropy values are always expressed relative to particular reference conditions.   
Many people forget that the values of enthalpy and entropy that are found in published tables 
are not absolute values but instead, are relative to particular reference conditions.  Engineering 
calculations always deal with enthalpy or entropy differences, typically between in-flowing and 
out-flowing streams.  For this reason, it does not matter what you select as the reference 
conditions, as long as you use them consistently.  @Air allows you to select reference 
conditions consistent with ASHRAE or an alternate set of conditions based on absolute zero 
temperature.   

In SI units, ASHRAE uses a reference condition of 0 °C and one atmosphere of pressure for 
dry air.  For water vapor, ASHRAE used a reference condition of liquid water at the triple point 
temperature of 0.01 °C.  In English units, however, ASHRAE uses a reference condition of 0 °F 
at one atmosphere of pressure for dry air properties while maintaining the convention of using 
the triple point as a reference temperature for water properties.  The @Air functions will use a 
reference temperature of 0 °F if an English unit set is selected or 0 °C if an SI unit set is 
selected. 

If you try to convert enthalpy (or entropy) values from English to SI units using standard 
conversion factors, you will find a difference equal to the difference in dry air enthalpy (or 
entropy) between 0 °F and 32.018 °F.  You can avoid this problem by converting the input 
parameters (e.g. pressure and temperature) to either English or SI units before calling the 
desired @Air function. 

As an alternative, you can set the reference temperature for the dry air portion to absolute 
zero, (0 °K) by adding an “A” to the unit set name or adding 8 to the unit set number.  In this 
case the 0 °K reference temperature will be used for any of the English or SI unit sets. 

For example in Excel, you can calculate the enthalpy of moist air with 0 °K reference 
temperature at a pressure of 15 psia, a temperature of 150 °F and a humidity ratio of 0.015 as 
follows: 

 =AirPTWH(15,150,0.015,”EngA”) 

Please note that in all cases, the enthalpy and entropy of the water portion are set to zero for 
liquid water at the triple point temperature.   Some publications, which are based on perfect 
gas assumptions, assign the zero point for enthalpy and entropy to water in the vapor state at 
the triple point or some other specified temperature.  We believe that setting the zero point for 
enthalpy and entropy to water in the liquid state rather than in the vapor state has two major 
advantages.  First, the values are numerically equivalent to standard international steam tables 
(and Techware’s WinSteam product).  This facilitates the handling of processes that include 
both moist air and liquid water streams without worrying about reference temperatures.  
Second, It greatly simplifies analysis of processes in which water is either condensed from or 
evaporated to the air stream. 

All reference conditions use the International Temperature Scale of 1990 (ITS-90) described in 
reference (5) as the basis of temperature. 
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2.3 USING @AIR FROM EXCEL 

@Air 4.0 supports 32-bit and 64-bit versions of Microsoft Excel.  If you followed the guidelines 
in the Installation Instructions, you should have the proper version of the Excel add-in installed.  
Before you can use the @Air functions in Excel, you have to load the add-in using the Excel 
Add-in Manager.  The procedure for activating the add-in is slightly different for 32-bit and 64-
bit versions and so separate instructions are provided. 

2.3.1 Loading the @Air Functions into Excel (32-bit) 

Once you have started Excel, use the Tools, Add-ins menu to start Excel’s Add-In Manager.   
(In Office 2007, click the Office button, then click the “Excel Options” button, then select the 
Add-ins tab and click the “Go…” button at the bottom.  In Office 2010, you can get to the Add-
ins tab by clicking the File menu and then the Options item.)   You should see an item “@Air 
for Excel” in the list box.  If you did not find “@Air for Excel” in the Add-in Manager list box, 
click the ‘Browse’ button and look for the file XLAir32.xll.  It should be in the C:\Program 
Files\Microsoft Office\OfficeXX\Library directory, where OfficeXX is the latest Office version 
installed. When you find it, click OK.  “@Air for Excel” should now appear in the list box.  If you 
are running Windows 7, look in the C:\Program Files (x86)\Microsoft Office\OfficeXX\Library 
directory for the file. 

Click the check box next to “@Air for Excel” and press ‘OK’.  The @Air copyright notice should 
be displayed on the status bar at the bottom of Excel.  The @Air add-in is now loaded into 
Excel and will reload every time you start Excel.  If you do not want the Add-in to load each 
time you start Excel, go back to the Add-in Manager and uncheck the @Air box before closing 
Excel. 
Once selected this way using the Add-in Manager, the functions will be loaded automatically, 
each time you start Excel.  If you wish to unload the functions, use the Add-In Manager and 
uncheck the box labeled “@Air for Excel”.  Thereafter, @Air for Excel will not load until you 
select it again using the Add-In Manager as described above. 

2.3.2 Loading the @Air Functions into Excel (64-bit) 

Once you have started Excel, click the File Menu, then click the “Options” button, then select 
the Add-ins tab and click the “Go…” button at the bottom.   Click the ‘Browse’ button and look 
for the file XLAir64.xll.  It should be in the C:\Program Files\TechwareEng\@Air (x64) directory. 
When you find it, click OK.  “@Air for Excel 2010” should now appear in the list box. 

Click the check box next to “@Air for Excel 2010” and press ‘OK’.  The @Air copyright notice 
should be displayed on the status bar at the bottom of Excel.  The @Air add-in is now loaded 
into Excel and will reload every time you start Excel.  If you do not want the Add-in to load 
each time you start Excel, go back to the Add-in Manager and uncheck the @Air box before 
closing Excel. 
Once selected this way using the Add-in Manager, the functions will be loaded automatically, 
each time you start Excel.  If you wish to unload the functions, use the Add-In Manager and 
uncheck the box labeled “@Air for Excel 2010”.  Thereafter, @Air for Excel will not load until 
you select it again using the Add-In Manager as described above. 
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2.3.3 Using the @Air Functions 

Once the add-in is loaded, the air property functions are available in the same ways as Excel's 
built-in functions.  That is, they can be typed into cell formulas or they can be inserted by 
pressing the fx button while creating a cell equation or using the Formula Paste Function menu 
selection.  When using either of the two latter methods, the air property functions will be sorted 
alphabetically in a function category called “Engineering”.  Generally, you can use any of the 
functions listed in section 2.2 in any cell formula.  Be sure to prefix the function name with an 
"=" character if it is the first or only item in a formula.  The line below presents an example of a 
call to an air property function from Excel assuming that the pressure is in cell A1, the 
temperature is in cell B1, the humidity ratio is in cell C1 and all values are in English units: 

=AirPTWH(A1,B1,C1,”Eng”) 

The @Air package includes a sample Excel spreadsheet file named EXAMPLE.XLS, which 
demonstrates the air property functions using various unit set arguments.  You can find this file 
in a “Samples” folder in the @Air program folder. 

Since the @Air property functions make many floating-point calculations, they can add to a 
spreadsheet's recalculation time.  You may find it desirable to set the spreadsheet to manual 
recalculation rather than automatic. 

The @Air functions can use any of several unit sets and a variety of options, all of which are 
accessed using the unit set argument.  This allows different unit sets and options to be mixed 
in the same spreadsheet.  Please see section 2.2 for instructions regarding the use of these 
features. 

2.4 USING @AIR FROM 1-2-3 

@Air works with 32-bit versions of 1-2-3 including 1-2-3 97 and 1-2-3 Millennium.  You must 
load the add-in file named 123AIR.12A to access the air property functions from 1-2-3.  When 
the add-in is loaded into memory it establishes links between 1-2-3 and the @Air dynamic link 
library. 

Use the File, Add-Ins, Manage Add-ins menu selections to start the Add-In manager.  Before 
you can use the @Air add-in for the first time, you must register the add-in by pressing the 
'Register..' push-button.  If installed using the default values, the file 123AIR.12A should be in 
the \LOTUS\123\ADDINS directory and will be shown in the Register Add-Ins window.  If you 
installed the file elsewhere, you will have to use the 'Look in' window to search for the file.  
When you have located the 123AIR.12A file, select it and press the 'Open' push-button.   The 
add-in is now registered with 1-2-3. 

To load the add-in after it is registered, click on the path name that has the 123AIR.12A file.  A 
check mark will appear to the left of the path name indicating that the add-in is selected.  Press 
the 'Done' push-button to complete the task.   

Thereafter, each time you start 1-2-3, the functions will be loaded automatically.  If you wish to 
unload the functions, use the Add-In manager to un-check the add-in.  Thereafter, the 
123AIR.12A add-in will not load until you select it again using the Add-In manager as 
described above but it should be unnecessary to go through the registration process again. 
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Once the add-in is loaded, the air property functions can be used in any cell formula by typing 
the function name in the same ways as 1-2-3's built-in functions.  If you need help, use the 1-2-
3 Help menu and select the '@Air Help' item.  This will launch an interactive help window, 
which provides information regarding the functions and their usage. 

Generally, you can use any of the functions listed in section 2.1 in any cell formula simply by 
prefixing the function name with an "@" character.  The @Air package contains a sample 1-2-
3 spreadsheet file named EXAMPLE.123 which makes several typical calls to the air property 
functions. 

The line below presents an example of a call to an air property function from 1-2-3: 

 @AirPTXH(A1,B1,C1,”SI”) 

The argument "A1" is for the air pressure and can be a cell reference or an actual pressure 
value.  In a similar manner, "B1" is for temperature and "C1" is for the humidity ratio.  The last 
argument selects the units set and any options. 

This syntax actually calls an add-in function in the 123AIR.12A add-in.  These add-in functions 
perform error checking and return an appropriate 1-2-3 error value when necessary - typically 
when input arguments are out of range or when too many arguments are supplied to the 
function.  1-2-3 will not accept a cell formula that contains a function reference with too few 
input arguments.  The 123AIR add-in functions themselves, call functions in TAIR32.DLL to 
actually perform the calculations. 

The @Air functions can use any of several unit sets and a variety of options, all of which are 
accessed using the unit set argument.  This allows different unit sets and options to be mixed 
in the same spreadsheet.  Please see section 2.2 for instructions regarding the use of these 
features. 

2.5 USING @AIR FROM MATHCAD  

The @Air add-in for Mathcad is a self-registering DLL.  All that is required for Mathcad to 
access the functions is that the add-in file, MCDAIR32.DLL, be located in the 
WINMCAD\USEREFI directory.  Whenever a @Air function is used, Mathcad will automatically 
load and register the function. 

The @Air add-in for Mathcad allows the use of any of the unit sets.  Mathcad, however, allows 
only pure numbers (without units) to be passed to and from user-defined functions.  The last 
argument in each function call is the unit set designator and can have a value from 0 to 127 
depending upon the selection of base unit set and the unit set options.  The other arguments to 
the function must be numbers without units whose values are consistent with the selected unit 
set. 

The @Air package contains a sample Mathcad file named EXAMPLE.MCD, which makes 
typical calls to the air property functions and illustrates the use of the unit set designator. 

Although on-line help for @Air is not directly available from within Mathcad, the Choose 
function feature does recognize the @Air functions and assists the user with the functions.  
Use the Math, Choose Function menu selections to open the Choose Function window.  Scroll 
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down the 'Function name is' box to find all of the air functions listed in alphabetical order.  The 
'Returns' box will describe the input arguments and the return value for the function that is 
selected.  Pressing the 'Insert' push-button will copy the function to your worksheet with 
placeholders for each function argument. 

2.6 USING @AIR FROM VISUAL BASIC 

The air property functions can be used directly in your Visual Basic programs just like the built-
in functions.  Before the functions can be used, however, they must be declared as functions 
and Visual BASIC must be told where to find them.  This can all be accomplished by including 
a DECLARE statement for each of the air property functions in either the Form code or in the 
Global code.  The DECLARE statement must include the name of the function, the dynamic 
link library where it can be found (TAIR32.DLL) and the list of arguments (which must all be 
passed by value, 'ByVal').  A sample DECLARE statement is as follows: 

Declare Function AirPTW Lib "TAIR32.DLL" (ByVal P As Double, ByVal T 
As Double, ByVal UnitSet As Integer) As Double  

If you are using a 64-bit version of Office, the DLL name is “TAir64.dll” instead of “TAir32.dll” 
and you must include the term “PtrSafe” after the keyword “Declare”, for example: 

Declare PtrSafe Function AirPTW Lib "TAIR64.DLL" (ByVal P As Double, 
ByVal T As Double, ByVal UnitSet As Integer) As Double  

A text file, TAIRVBDEC.TXT, which lists declarations for all of the @Air functions is included in 
the @Air package in the \Programming subdirectory. 

If you are using the @Air functions in an Excel Visual Basic module to create additional 
functions, you should use a different name to declare the functions or else they will conflict with 
the functions in the XlAir.xll add-in.  In this case, you must use the ALIAS keyword in the 
declaration to identify the true name in the DLL.  For example, 

Declare Function MyAirPTWH Lib "TAIR32.DLL" ALIAS "AirPTWH" (ByVal P 
As Double, ByVal T As Double, ByVal W As Double, ByVal Unitset As 
Integer) As Double 

If you are using a 64-bit version of Office, the DLL name is “TAir64.dll” instead of “TAir32.dll” 
and you must include the term “PtrSafe” after the keyword “Declare”, for example: 

Declare PtrSafe Function MyAirPTWH Lib "TAIR64.DLL" ALIAS "AirPTWH" 
(ByVal P As Double, ByVal T As Double, ByVal W As Double, ByVal 
Unitset As Integer) As Double 

A text file, TAIRVBADEC.TXT, which lists declarations using the Alias format is included in the 
@Air package in the \Programming subdirectory. 

With each TAIR32 function call, your code should check to ensure that the values returned are 
greater than -1000.  Return values of -1000 or smaller indicate error conditions.  See the 
Appendix for a listing of error codes and their meanings. 
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2.7 USING @AIR WITH PROGRAMMING LANGUAGES 

The air property functions in TAIR32.DLL  or TAIR64.DLLcan also be called from within C/C++ 
programs compiled to run under Windows.  Prototypes for all functions are provided in the file 
named TAIRPROTO.H.  All files needed to support your programming applications can be 
found in the \Programming directory if you choose to install programming support during 
installation.  You may also find it convenient to include the file named AIRERR.H.  It defines 
mnemonic constants for the various error values returned by air functions.  The compiled code 
should also be linked with the import library named TAIR32.LIB or TAIR64.LIB as appropriate. 

With each air property function call, your code should check to ensure that the values returned 
are smaller (more negative) than -1000.  Return values of -1000 or smaller indicate error 
conditions.  See the Appendix for a listing of error codes and their meanings. 

2.8  VERSION AND SERIAL NUMBER 

There may be new releases of @Air to add features or to support new applications. Each new 
release of @Air will have a version number that is printed on the diskette label.  The 
TAIR32.DLL file has its own version number, which may differ from the @Air version number.  
Every copy of @Air sold is provided with a unique serial number.  You can identify the version 
of the DLL and serial numbers of your copy by using the AirVer function, which takes no 
arguments.  In Excel, an empty pair of parentheses is needed.  In 1-2-3 no parentheses is 
needed.  The AirVer function returns a floating-point number containing the information (e.g., 
4.071234).  The first two digits indicate the DLL version number.  The next five digits make up 
your copy's serial number. 

The serial number also can be found by selecting About on the Help menu of DeskTop Air.  
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3. USING DESKTOP AIR 

3.1 OVERVIEW 

DeskTop Air is a Windows application, which calculates the thermodynamic and transport 
properties of moist air.   It can be used as an interactive replacement for air property tables 
and psychrometric charts but does much more than that.  It automatically calculates all 
unknown properties when a state point is defined by known properties.  The program is 
flexible, and designed to minimize keystrokes for common calculations.  DeskTop Air allows 
you to enter any number of state points, label them and store the collection of points for later 
reference.  You can print a table of stored points or copy them to the clipboard and paste them 
into your favorite spreadsheet or word processor. 

Major features of this program include: 

• validity over @Air’s full range of pressures and temperatures 
• flexible  interactive design 
• large choice of units for each property 
• tools for heating, cooling, expansion and compression processes 
• instant response time 
• extensive help screens 

 
If installed properly, DeskTop Air is started by simply double clicking on its name/icon in the 
@Air subgroup of the TechwareEng Group appearing in the Windows Start Menu. 

3.2 BASIC OPERATION 

The DeskTop Air display is arranged in a tabular format that remains constant although the 
program window can be re-sized.  You may sometimes find it convenient to make the program 
window smaller.  Each of the rows is dedicated to one of the air properties (pressure, dry bulb 
temperature, specific volume, enthalpy, entropy, wet bulb temperature, dew point, relative 
humidity, humidity ratio, degree of saturation, H2O mole fraction, H2O mass fraction, 
molecular mass, specific heat, dynamic viscosity and thermal conductivity).   There is a column 
that displays the property values for the active point and a column that displays data for one of 
the stored points. 

The key properties that can be used to define the air state point are: pressure, temperature, 
specific volume, enthalpy, entropy, and one of the moisture indicators.  Theoretically, a state 
point can be uniquely identified by specifying the moisture content and any two of the other five 
properties.  On a Psychrometric chart, the state point is normally determined as the 
intersection of two lines, which represent two variables.  Only two values are required on the 
Psychrometric chart because the chart is valid for only a single air pressure.  In most practical 
applications, pressure is usually one of the known variables.  Most of the calculations require 
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that the pressure be known.  In the rare case when pressure is not known, it can be calculated 
from the equation of state if the dry bulb temperature, specific volume and humidity ratio is 
known.  

Each of the key properties has a check box associated with it.  When checked, it signifies that 
this property is to be used in calculating the state point.  In general, two thermodynamic 
properties and one other property, which indicates the moisture content, must be selected 
before DeskTop Air will allow a computation.  There are some combinations of only two 
properties that allow computation in the saturated state.  In these cases, you will notice that the 
‘Compute Saturated’ button is enabled.  Once you select one property, DeskTop Air will 
disable all the other check boxes whose properties are not allowed in combination with the first 
selected property.  You may change your selections by un-checking one or all of the check 
boxes and selecting a new combination. 

To compute an air property state point, begin by selecting the input properties and set the 
corresponding check boxes as described above.  Enter values for those properties in the 
boxes to the right of the property names.  (The next section describes various methods for 
entering data.)  When you enter a value for any of the key properties, a red “X” appears next to 
the property value to indicate that a new value has been entered.  This is a warning that the 
value being displayed is not consistent with the current state point.  After a compute command 
is completed successfully, all property values are recalculated and the red “X’s” are cleared. 

Be sure to enter the values in units consistent with the unit displayed to the right of the value 
box.  If you wish to change units, select the desired units before entering the value.  If you 
change units after the value is entered, the value entered will be converted to the new units.   

Next, click the 'Compute' button to find all the unknown properties. If the ‘Compute’ button is 
grayed, you have not checked enough properties to define the state point.  Fields without 
check boxes are output only.  These include molecular mass, specific heat, viscosity and 
thermal conductivity.  After recalculation, all fields contain property values for moist air at a 
particular state point. 

The box labeled “Reference” identifies the reference conditions for the property values.  It 
indicates whether the values are on a wet or dry basis, the reference pressure for entropy and 
the reference temperature for dry air enthalpy and entropy. 

3.3 ENTERING DATA 

Numeric data is entered in a specially designed edit box called an IO Box, which behaves like 
a standard Windows edit box but includes some additional features.  To enter new data, 
double click the IO Box and all the data will be highlighted.  As you enter new data, the old 
data will be replaced.  To edit data, hold the left mouse button down and drag the mouse over 
the characters that you wish to replace, thereby highlighting them.  Release the mouse button 
and type new characters to replace the highlighted ones. 

The IO Box has two modes of operation, input and output.  When new data is entered, the IO 
Box is placed in the input mode and a red X appears to the left of the box.  After a new state 
point is computed, all IO Boxes are placed in the output mode and the red X’s are removed. 

@Air for Windows Version 4.0 - User's Manual 



Chapter 3 - Using DeskTop Air  Page 16 

The IO Box accepts either numerical values or arithmetic expressions that can be evaluated to 
a numeric value.  A number can be entered in either decimal or scientific notation.  The 
expression can be any valid arithmetic expression using the following operators: 

+  add 
- subtract 
* multiply 
/ divide 
^ exponent 
( ) parentheses 

Arithmetic calculations can be nested to any level using parentheses. An example of a valid 
expression is: 

((1004^2 + 997^2) / 2)^.5 

which evaluates to 1000.506. 

Expressions are evaluated whenever you tab to or click on another control or press the ‘Enter’ 
button.  Only the resulting value is shown in the box.  If you enter an incorrect expression, your 
computer will beep and the edit cursor will highlight the offending character.  You must fix the 
error before DeskTop Air will allow you to continue. 

If the expression you are entering is too long to fit in the box, the box will temporarily increase 
in length so that you may view more of the expression.  When you are finished editing, the box 
returns to its original length. 

To recall the last expression used in an input box, use the 'Recall Expression' command on the 
'Edit' menu.  You’ll then have the opportunity to edit the expression and let the IO Box re-
evaluate it.  Note that the box retains the last number or expression entered even after a 
compute command is issued.  As a result, the value in the box will not reflect the value of the 
recalled expression if a compute command has altered the value. 

You may use the ‘Cut’, 'Copy' and 'Paste' commands on the 'Edit' menu or the toolbar to 
exchange numeric data between DeskTop Air’s IO Boxes and any other application that 
supports the clipboard.  If you start entering data in an IO Box and wish to go back to the 
original data you may use the 'Undo' command on the 'Edit' menu.  However, once the IO Box 
loses the focus, the 'Undo' command is no longer available. 

3.4 UNIT SELECTION 

DeskTop Air allows you to use any combination of units for input and output properties.  The 
units for each property can be set independently by using its associated combo box. To 
change a unit, select its combo box and scroll through the list of available units using either the 
keyboard cursor arrows or the mouse.  Whenever a new unit is selected, the program converts 
the values displayed for that property to the new units.  Therefore, when entering data you 
should first select the units and then key in the input values.  Otherwise, the values will be 
converted to the new units and you will have to re-enter them. 

The first time the program is started, the properties will be displayed in SI units.   You can 
change all of the units to either standard English or SI units by issuing the 'English Units' or 'SI 
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Units' command from the 'Format' menu or pressing the ‘Eng’ or ‘SI’ toolbar button.  When you 
change to English units in this manner, the reference temperature for dry air is changed to 
0 °F.  Similarly, when changing to SI units, the reference temperature is changed to 0 °C. 

You may choose any combination of available units for your default unit set.  Simply select the 
units you desire for each property and issue the 'Use Settings As Default' command from the 
'Format' menu.  The next time you start DeskTop Air, your default unit set will be used. 

If you change units and then save a file, those selected units will be restored whenever the file 
is opened.  If you wish to change the units back to your default unit set, issue the command 
'Restore Default Settings' from the 'Format' menu. 

Unit system changes in DeskTop Air do not affect use of @Air from any other applications 
(e.g., Excel, 1-2-3, etc.). 

3.5 CALCULATING STATE POINTS 

When you have finished entering values for the selected input variables, click the on-screen 
button labeled 'Compute' to calculate all of the state point properties.  If the ‘Compute’ button is 
grayed, you have not checked enough properties to define the state point.   

You may also compute the state point by pressing the 'Enter' key on your keyboard.  Note that 
the 'Enter' key serves two purposes in DeskTop Air.  Pressing the 'Enter' key just after entering 
data in an IO Box, tells DeskTop Air to evaluate the expression in the IO Box.  Pressing the 
'Enter' key a second time tells DeskTop Air to compute the state point.  If you move the focus 
to any other control after entering data in an IO Box, the expression is evaluated automatically 
and you only have to press the 'Enter' key only once to compute the state point.   The ‘Enter’ 
key will not compute a state point if the ‘Compute’ button is grayed. 

3.6 FORMATTING PROPERTY VALUES 

DeskTop Air normally displays all property values in fixed decimal notation.  You may increase 
or decrease the number of decimal places in a selected property IO Box by selecting ‘Add 
Decimal Places’ or ‘Decrease Decimal Places’ from the ‘Format’ menu or by clicking either of 

the  toolbar buttons, respectively.   

If you wish to change the selected property to scientific notation, select the 'Scientific Notation' 
command from the ‘Format' menu or press the ‘EE’ toolbar button.  The ‘Format’ menu many 
be used to change the number format to 'Fixed Decimal' or 'Percent' as well.  Corresponding 
toolbar buttons are ‘Fix’ and ‘%’ respectively. Of course, the percent format only makes sense 
for the non-dimensional properties. 

The formatting commands are only enabled when the focus is on an IO Box. 

3.7 LABELING AND STORING STATE POINTS 

DeskTop Air gives you the option of labeling and storing any number of state points for future 
reference.  After computing the state point, DeskTop Air will automatically suggest a unique 
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name for the new state point such as Point 1 or Point 2, but you will probably want to enter 
something more descriptive.   Just enter a new name in the Point Label box.   

To store this point, press the 'Store Point' button. (The Store button will not be enabled if the 
displayed data is not a correctly calculated state point.) DeskTop Air requires all stored points 
to have a unique label.  If you try to store two points with the same label, DeskTop Air will 
query whether you wish to replace the stored point, which has the same label, with the current 
point.  If not, you should rename the point and try to store it again.   

After storing the point, the state point values for the active point will be copied into a storage 
array and given the name you selected.  The point will be displayed in the stored points 
column in same units as the active point.  After a state point is stored, its name is added to the 
point name combo box in the upper right hand corner of the main window. You can view a 
stored point by pressing the arrow on the point name combo box and selecting a point from the 
drop down list.  

If you wish to use a stored point with any of the special tools or as the basis for calculating a 
new point, you must recall the stored point to the active point.  Begin by selecting the point 
from the point name combo box’s dropdown list.  Next, press the ‘Recall Point’ button to copy 
the stored point to the active point.  You may now use the active point for new calculations.  If 
you change any input data and press 'Compute', the active point will be changed but the stored 
point from which you copied the values will remain intact.   

You can delete a stored point by first selecting it from the Point Name combo box and then 
select 'Delete Point' from the 'Edit' menu. 

This collection of state points can be saved as a DeskTop Air file.  In addition, you can copy 
state points to the clipboard, where they can be transferred to another application such as a 
spreadsheet program or word processor. 

3.8 PRINTING  

You can print a table consisting of all of the stored points by selecting the Print command from 
either the file menu or the toolbar.  The tables will include a column for each of the stored 
points with each of its properties listed in a row.  A label for each row includes the property 
name and the current units selected.  The printing utility will attempt to fit as many points on a 
page as possible, based on the paper size and orientation that you specify using the ‘Print 
Setup’ command.  You can preview the output by selecting the ‘Print Preview’ command from 
the ‘File’ Menu. 

3.9 SAVING AND OPENING DATA FILES 

When you start DeskTop Air or open a new file, it will be untitled.  You may save a collection of 
stored state points along with your selections of units and formats to a DeskTop Air file.  Select 
'Save' from the 'File' menu or click the disk icon on the toolbar, which will open the “Save As” 
dialog box.  You should enter a name for the file; the file extension “.air” will be added 
automatically.  You may choose a folder in which to save the file or accept the default folder. 

If you have saved the file at least one time during the session, you can save the work under a 
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different filename by choosing the ‘Save As’ command from the ‘File’ menu. 

To open a saved file, select 'Open' from the 'File' menu or click the open file icon on the 
toolbar.  This will open a dialog box that lists all of your DeskTop Air data files in the current 
folder.  You may select a different folder to view other files.  Select the file you want to open 
and press the ‘Open’ button to load the file. 

To start a new file, select the 'New' button from the Toolbar.  If you have stored any points and 
have not saved the file, you will be prompted to do so. 

3.10 ADVANCED FEATURES 

DeskTop Air includes special tools that facilitate the calculation of some common air 
processes.  These tools include an expansion/compression tool and a heating/cooling tool. 

3.10.1 Expansion/Compression Tool 

The Expansion/Compression tool is used to evaluate performance of an air turbine or an air 
compressor.  If you are predicting the performance and know the efficiency of the turbine or 
compressor, the tool can be used to calculate the state point conditions at the expansion or 
compression end point.  If you are analyzing the performance of a turbine or compressor and 
know the conditions at the end point, the tool can be used to calculate the efficiency.  The tool 
also computes the energy converted to shaft work generated by the turbine or used by the 
compressor. 

To use the tool, first select the active state point representing the start of the expansion or 
compression path.  Next, select 'Expand/Compress' from the 'Tools' menu or click the turbine 
icon on the toolbar, which will open the Expansion/Compression tool dialog box.   

In the tool dialog box, select the conditions you will use the compute the end point from the 
combo box near the top of the screen.  Select “Pressure & Efficiency” if you know the pressure 
and efficiency.  If you are checking an actual machine you will need to know the exiting air 
temperature or enthalpy.  Check either the “Pressure, Enthalpy” or Pressure, Temperature” 
buttons as required.  The two variables you have chosen will have their value fields enabled; 
all others will be grayed.  Enter the appropriate values and click the 'Compute' button. 

The “Air Flow In” column displays the state point properties entering the equipment, which 
were copied from the active point.  The “Total Flow Out” box has three columns that display 
the state point properties at the end of the expansion.  The first column identifies the 
thermodynamic properties for the mixture of moist air and liquid water exiting the equipment.  
The second column displays the thermodynamic properties for the moist air exiting and the 
third column shows the properties for the liquid water if any condensation occurs. The units 
displayed are those currently in use on DeskTop Air’s main window.  If you wish to use 
different units, you should select those units on the main window before opening the expansion 
tool. 

Below the state point properties, you will find the shaft power based on the entering air flow 
rate that you entered.  The units for these results will be consistent with your input units.  

You may change any of the data and repeat the calculation as required.  When you are 
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satisfied with the result, you may copy that state point back to the active point on DeskTop 
Air’s main window by pressing the 'OK' button.  Note that the values of moist air in the second 
column will be copied back to the active point.  If no condensation has occurred, these values 
will be the same as in the first column labeled mixture.  If condensation has occurred, then the 
values in the second column will be at saturated conditions.   

If you do not wish to replace the current point on the main window with the expansion end 
point calculated, just press the 'Cancel' button. 

3.10.2 Heating/Cooling Tool 

The Heating/Cooling tool is used to analyze an air stream in which heat is either added or 
removed.  If you know the quantity of heat that is being added to or removed from the air 
stream, you can use the tool to calculate the resulting state point temperature and other 
conditions.  If you know the temperature or enthalpy of the air leaving the heating or cooling 
device, you can use the tool to calculate the quantity of heat exchanged.   

To use the tool, first make sure that the active state point represents the conditions of the air 
entering the heating or cooling device.  Next, select 'Heat/Cool Tool' from the 'Tools' menu or 
click the flame icon on the toolbar, which will open the Heating/Cooling tool dialog box.   

In the tool dialog box, select the conditions you will use to compute the end point from the 
combo box near the top of the screen.  Select “Pressure, Heat Flow” if you know the pressure 
and heat added or removed.  If you are measuring performance on an existing device you will 
need to know the exiting air temperature or enthalpy.  Check either the “Pressure, Enthalpy” or 
“Pressure, Temperature” buttons as required.  The two variables you have chosen will have 
their value fields enabled; all others will be grayed.  Enter the appropriate values and click the 
'Compute' button. 

The “Air Flow In” column displays the state point properties entering the equipment, which 
were copied from the Active Point in the main screen window.  The “Total Flow Out” box has 
three columns that display the state point properties at the end of the expansion.  The first 
column identifies the thermodynamic properties for the mixture of moist air and liquid water 
exiting the equipment.  The second column displays the thermodynamic properties for the 
moist air exiting and the third column shows the properties for the liquid water if any 
condensation occurs. The units displayed are those currently in use on DeskTop Air’s main 
window.  If you wish to use different units, you should select those units on the main window 
before opening the Heating/Cooling tool. 

Below the state point properties, you will find the heat added based on the entering airflow rate 
that you entered.  The units for these results will be consistent with your input units.  

You may change any of the data and repeat the calculation as required.  When you are 
satisfied with the result, you may copy that state point back to the Active Point on DeskTop 
Air’s main window by pressing the 'OK' button.  Note that the values for moist air in the second 
column will be copied back to the active point.  If no condensation has occurred, these values 
will be the same as in the first column labeled mixture.  If condensation has occurred, then the 
values in the second column will be at saturated conditions.   

If you do not wish to replace the Active Point on the main window with the heating/cooling state 
point calculated, just press the 'Cancel' button. 
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3.10.3 Exchanging Data with Other Programs 

DeskTop Air includes two ways to share data with other applications running on your PC such 
as Excel.  Both methods use the Windows clipboard.   

In the first data sharing method, DeskTop Air's 'Edit / Copy' command copies whatever text is 
highlighted in an IO Box (e.g., a number or part of a number) to the Windows clipboard.  From 
there, that text can be pasted into other applications running on your PC.  This is typically done 
using those applications’ 'Edit / Paste' command). 

The second data sharing method also places text on the clipboard but uses an extended 
format that is especially useful for calculations involving air properties.  This method is 
accessed using the 'Copy Point' command on the 'Edit' menu.  Regardless of whether any text 
is selected, this command copies a table of text values to the clipboard using either the Active 
Point or all of the stored points.  The table includes one column for each point. You can 
optionally direct DeskTop Air to also include property and unit labels in which case they appear 
as the first column in the table.  The table includes one row for each property in the same order 
as they are displayed on DeskTop Air’s main window.  All values are copied to the clipboard 
using the same format displayed on the screen.  So, if you need more accuracy in your Excel 
calculations, set the DeskTop Air display accuracy accordingly, before issuing the 'Copy Point' 
command. 

3.11 GETTING HELP 

The Help menu offers extensive on-line help for DeskTop Air.  The 'About' item in the Help 
menu presents the version and serial numbers of your copy of @Air. 

3.12 ERROR MESSAGES 

When input values are out of range or any other errors occur, a message box is displayed 
describing the error.  The calculated fields will not be updated until the error condition is 
resolved. 

3.13 EXITING DESKTOP AIR 

You may exit DeskTop Air by using any of the standard methods for closing Windows 
applications.  These include the following: 

• Click the upper left corner of its program window and select close from the menu. 

• Select Exit from the File menu. 

• Press Alt + F4 keys. 

• Click the “X” button in the upper right corner of the program window 
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4. THEORETICAL BASIS OF @AIR FUNCTIONS 

4.1 BASIS OF CALCULATIONS 

The formulations used in developing the air property functions treat moist air as a mixture of 
two real gases, namely, dry atmospheric air and water vapor.  Furthermore, dry atmospheric 
air is assumed to be a homogeneous, single-component gas with an apparent molecular 
weight of 28.9645 g/mol.   

The P-V-T behavior of the mixture is described by a virial equation of state: 

  

 
Pv
RT

B
v

C
v

m m= + + +1 2 L 

where, 

  = Total pressure P

 T  = Absolute Thermodynamic Temperature 
 v  = Total volume of gas 
 R  = Universal Gas Constant 
 = second order virial coefficient of the mixture Bm

  = third order virial coefficient of the mixture Cm

For the ranges of pressure and temperature used in these functions, the higher order 
coefficients can be ignored.  It can be shown for the air-water mixture that 

   B x B x x B x Bm a aa a w aw w w= + +2 22 w

and 

  C x C x x C x x C x Cm a aaa a w aaw a w aww w www= + + +3 2 2 33 3

where, 
  = mole fraction of air in the mixture xa

  = mole fraction of water in the mixture xw

  = virial coefficients of air B Caa aaa,



Chapter 4 – Theoretical Basis of @Air Functions Page 23 

@Air for Windows Version 4.0 - User's Manual 

  = virial coefficients of water vapor B Cww www,

  = virial coefficients of the mixture B C Caw aaw aww, ,

ASHRAE uses polynomial equations for estimating the virial coefficients of air and water vapor 
as presented by Hyland and Wexler [8].   These equations are derived from the data presented 
by the NBS [1] .   While these equations produce reasonable results, they are limited in 
temperature range from about -100 °C to 200 °C and are clearly inadequate for this 
application, which supports temperatures up to 2000 °K.   

Instead of using polynomial equations, Techware has developed a gas property database from 
the NBS [1] data.  The database includes virial coefficients as well as ideal gas properties for 
enthalpy, entropy and specific heat that span the range of temperatures from 180 °K to 
2000 °K.  Coefficients are extracted from the database at any desired temperature using non-
linear interpolation. 

The molar enthalpy of moist air, hm can be described by the equation 

  ( ) (h x h h x h hm a a
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where, 

  = ideal gas molar enthalpy for air ha
o

  = ideal gas molar enthalpy for water hw
o

  = constant to adjust reference state for air ha
'

  = constant to adjust reference state for water hw
'

The molar entropy of moist air, sm can be described by the equation 
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where, 

  = ideal gas molar entropy for air sa
o

  = ideal gas molar entropy for water sw
o

  = constant to adjust reference state for air sa
'

  = constant to adjust reference state for water sw
'
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The molar specific heat at constant pressure of moist air, cm, can be described by the 
equation: 
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where, 

  = ideal gas molar specific heat of dry air at constant pressure o
ac

  = ideal gas molar specific heat of water vapor at constant pressure o
wc

For combinations of pressure and temperature below the boiling point of water, there is a 
maximum quantity of water that can exist at that temperature in the vapor state.  In this 
condition, the air is said to be saturated.  For the case where moist air exists in a saturated 
state, the mole fraction of water vapor, xws is given by 

 x fp
Pws =  

and the mole fraction of air, xas is given by 

 x P fp
Pas =
−  

where, 
  p  = the pressure of saturated vapor over pure condensed phase ice or 

water. 
  f = a dimensionless quantity introduced by Goff (1949) called the 

enhancement factor or excess solubility, which is equal to xws / 
xwsideal.   

  xwsideal = the ratio of the vapor pressure of the pure water, to the total 
pressure of the mixture. 

ASHRAE uses equations for estimating the enhancement factor as well as the virial 
coefficients of dry air and air/water mixture developed by Hyland and Wexler [8].  While earlier 
versions of @Air used these same formulations, this current version uses another method for 
calculating the enhancement factor presented by Rabinovich [3].  We believe that this method 
produces better correlation with the original experimental data developed by Goff.  Even so, 
the differences between the two methods are generally small. 
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Assuming that the condensed phase is pure water, the value of xws can be found by equating 
the chemical potential of pure condensed water with the chemical potential of its vapor in the 
gas solution.  Since the equations describing chemical potentials are non-linear and difficult to 
analyze, phase equilibrium is often described in terms of a thermodynamic function called 
fugacity.  The equality of chemical potentials can be replaced by equating the logarithms of the 
fugacity of pure condensed water with that of its vapor in the gas mixture solution.   The 
equation of solubility based on this concept is derived by Rabinovich [3] and can be expressed 
as follows: 
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where, 

 z
B
v

C
v

= + +1 2    the compressibility of the air mixture or the water vapor as required. 

  saturation pressure of water vapor at temperature T. p ws =

  the volume of the condensed water. vwcond =

The solubility equation can be solved for xws by iteration.  The value of xws is used to find the 
dew point temperature of a gas mixture, to determine the amount of condensation that occurs 
in a cooling process and to verify that the value of x input by the user does not exceed xws. 

4.2 HUMIDITY PARAMETERS 

In determining the thermodynamic properties of moist air, it is required to know the relative 
quantities of water vapor and dry air in the mixture.  The formulations described above use the 
mole fractions of air and water for this purpose.  In practice, it is common to use other 
parameters as well to define the proportions of air and water vapor in the mixture.  The most 
common of these parameters include humidity ratio, relative humidity, degree of saturation, 
wet bulb temperature and dew point temperature and mass fraction of water vapor.  @Air 
includes a number of functions whose purpose is to relate the various parameters for 
determining the level of moisture in the air. 

The functions use a key character to indicate each humidity parameter.  The key characters 
and the definitions of each parameter are as follows: 

 
a

w

M
M

RatioHumidity =  

where, 
 Mw = mass of water vapor in sample 
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 Ma = mass of dry air in sample  
As described in section on alternate moisture parameters, mole fraction or mass fraction of 
water vapor can be substituted for humidity ratio through the unit set argument. 

  
where, 
 xw = mole fraction of water vapor 
 xws = mole fraction of water vapor saturated at the same temperature and pressure 

 
sW

WSaturationofDegree =  

where, 
 W = humidity ratio 
 Ws = humidity ratio of saturated air at the same temperature and pressure 
  
Dew Point Temperature (D) is defined as the solution to the equation: 

   ( )W P D Ws s, =

It represents the temperature to which a sample of moist air at a given unchanging pressure 
can be cooled before condensation begins.  

Thermodynamic Wet Bulb Temperature (B) is the temperature at which water, by evaporating 
into moist air at a given dry-bulb temperature and humidity ratio, can bring the air to saturation 
adiabatically at the same temperature B while the pressure is maintained constant.  It is 
defined as the solution to the equation: 

 ( ) ( ) ( )[ ] ( ) ( )h P T W W P B W P T h B h P Bs w, , , , ,+ − =  s

where, 
  h(P,T,W) = enthalpy of the moist air sample at given pressure, dry bulb 

temperature and humidity ratio. 
  hw = enthalpy of water added at the wet bulb temperature. 
  hs(P,B) =   enthalpy of saturated air at the wet bulb temperature. 

   

4.3 TRANSPORT PROPERTIES 

Values for viscosity and thermal conductivity of dry air at atmospheric pressure can be found in 

ws 
w 

x 
x 

Humidity Relative = 
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many references although there does not appear to be any definitive standard of accepted 
values as there are for steam and water.  We found the most complete coverage by 
Vasserman, Kazavchinskii, and Rabinovich [2] who have surveyed the available literature and 
presented tables of values over a range of temperatures and pressures.  We have used their 
tabular values of viscosity and thermal conductivity as the basis of our database for dry air.  
We have also used their recommended polynomial adjustment factors as a function of density 
to account for variations associated with pressure. 

We have used the equations recommended by ASME (6) to compute the viscosity and thermal 
conductivity properties for water vapor.  These are the same equations used in our WinSteam 
product. 

There is little information available regarding the viscosity and conductivity of moist air.  In 
most practical cases, the relatively small quantity of water vapor in air has a small effect on the 
overall transport properties, unlike the thermodynamic properties, which are greatly affected by 
moisture.  Nonetheless, we have selected a method to account for the effects of moisture 
based on kinetic theory as presented by Hirshfelder, Curtis and Bird [4]. 

The equation for viscosity of a binary mixture is as follows: 
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 =aη  viscosity of dry air at the specified pressure and temperature 

 =wη  viscosity of water vapor at the specified pressure and temperature 
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In ilar manner, the equations for thermal a sim  conductivity of moist air is as follows: 
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=λ  thermal conductivity of the mixture 
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=aλ  Thermal conductivity of dry air at the specified pressure and temperature 

 =wλ  Thermal conductivity of water vapor at the specified pressure and temperature 
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5. SPEED AND ACCURACY CHARACTERISTICS 

5.1 SPEED OF CALCULATIONS 

This section addresses the @Air calculation speed as measured within Microsoft Excel.  
Performance within other applications is similar.   

The time required to recalculate a spreadsheet is a function of many features of the computer 
system hardware and the nature of the spreadsheet.  Since the supported spreadsheets use 
double precision math exclusively, calculation time is sensitive to the number and complexity of 
numerical equations used.   

The time required to perform the calculations also varies depending on the specific functions.  
Some calculations are more complex than others.  Some require iterations.  The simplest 
functions run the fastest while those that are more complex and require iterations run slower.  
The table below lists times required to calculate some typical @Air functions from Microsoft 
Excel. 

Function Calculation Time 

AirPTRW 0.00016 

AirPTWH 0.00001 

AirPWD 0.00070 

AirPHWT  0.00045 

Typical calculation times in seconds per calculation.  
 A calculation returns one property at one state point.   

These times were measured on a computer using a 233 MHz Pentium II processor.  
Calculation times will vary depending on your particular computer. 

Note that the recalculation options selected will also affect perceived calculation time.   

5.2 ACCURACY OF CALCULATIONS 

Thermodynamic properties for dry air calculated by @Air have been checked against the 
values published by NBS [1].  As shown on Exhibits 5.1 through 5.4, the calculated values 
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show excellent agreement with the source data throughout most of the valid range.  Some 
small differences can be observed at low temperatures and high pressures.  This is due to the 
limitations of using a third order virial equation of state.  Even so, the maximum error is less 
than 0.3% for thermodynamic properties and 3.17% for specific heat. 

Another smaller difference is shown in the compressibility factor between 1500 °K and 2000 
°K.  This is due to the dissociation of Nitrogen and Oxygen at these temperatures.  This error is 
less than 0.02%. 

The tables show some differences in enthalpy, entropy and specific heat occurring at 850 °K 
and growing with temperature.  This initially, was thought to be attributed to dissociation, but 
this was dismissed for two reasons.  First, dissociation effects were not included below 1500 
°K in reference 1.  Second, the error is much greater than what can be attributed to 
dissociation above 1500 °K.   

Further examination of the data tables suggests that the tables in reference 1 are in error.  One 
would expect the thermodynamic properties to approach the ideal gas properties as the 
pressure is reduced to zero.  While this is the case for temperatures up to 800 °K, it is not the 
case above 800 °K.  Curiously, at 800 °K, the tables in reference 1 change from a temperature 
increment of 10 °K to 50 °K at the point where the error begins.  Perhaps this change of 
temperature increment was not handled properly.   

Comparison of data from Vasserman et al [2] in the temperature range from 850 °K to 1300 °K 
supports the conclusion that the tables from NBS [1] are in error.  Unfortunately, the tables 
from Vasserman  et al [2] does not contain data for temperatures above 1300 °K. 

Moist air properties are compared against values published by ASHRAE [9] in Exhibits 5.5 – 
5.7, which show excellent agreement.  It should be noted that there are small differences in the 
saturated humidity ratio between @Air and ASHRAE, which are attributed to the different 
models used as explained in the section on basis of calculations.   

Exhibit 5.8 plots the enhancement factors from @Air and ASHRAE with the original 
experimental data from Goff.  This clearly shows that the model used by @Air provides better 
agreement with the original experimental data than the model used by ASHRAE.  Since the 
enhancement factor is the basis for calculating saturated humidity ratio, we place a higher 
confidence on the saturated humidity ratio calculated by @Air. 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
EXHIBIT 5.1 - COMPRESSIBILITY OF DRY AIR 

Temperature 
Range Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.001% 0.002% 0.019% 0.028% 0.125% 0.279% 

260 300 0.001% 0.001% 0.005% 0.008% 0.009% 0.014% 

310 350 0.001% 0.001% 0.003% 0.003% 0.009% 0.013% 

360 400 0.000% 0.001% 0.003% 0.004% 0.002% 0.004% 

410 500 0.001% 0.001% 0.003% 0.004% 0.010% 0.013% 

510 600 0.000% 0.001% 0.002% 0.003% 0.012% 0.013% 

610 700 0.001% 0.001% 0.001% 0.002% 0.008% 0.010% 

710 800 0.000% 0.001% 0.00`% 0.001% 0.004% 0.006% 

850 1450 0.000% 0.001% 0.001% 0.002% 0.002% 0.004% 

1500 2000 0.004% 0.016% 0.004% 0.006% 0.004% 0.010% 
         

  
COMPARISON OF RESULTS WITH NBS [1] DATA 

EXHIBIT 5.2 - ENTHALPY OF DRY AIR 

Temperature 
Range Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.00% 0.01% 0.03% 0.12% 0.13% 0.26% 

260 300 0.00% 0.00% 0.00% 0.01% 0.04% 0.07% 

310 350 0.00% 0.00% 0.00% 0.01% 0.01% 0.01% 

360 400 0.00% 0.00% 0.01% 0.01% 0.01% 0.01% 

410 500 0.00% 0.00% 0.00% 0.01% 0.01% 0.01% 

510 600 0.00% 0.00% 0.00% 0.00% 0.01% 0.01% 

610 700 0.00% 0.00% 0.00% 0.00% 0.01% 0.01% 

710 800 0.00% 0.00% 0.00% 0.00% 0.01% 0.01% 

810 1450 * 0.03% * 0.09% * 0.03% * 0.09% * 0.03% * 0.10% 

1500 2000 ** ** ** ** ** ** 
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COMPARISON OF RESULTS WITH NBS [1] DATA 
EXHIBIT 5.3 - ENTROPY OF DRY AIR 

Temperature 
Range Pressure 

From To 1 atm 10 atm 40 atm 

deg K Deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.00% 0.00% 0.01% 0.02% 0.02% 0.05% 

260 300 0.00% 0.00% 0.00% 0.00% 0.00% 0.01% 

310 350 0.00% 0.00% 0.00% 0.00% 0.00% 0.01% 

360 400 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

410 500 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

510 600 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

610 700 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

710 800 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

850 1450 0.00% 0.01% 0.00% 0.00% 0.01% 0.01% 

1500 2000 ** ** ** ** ** ** 

  
COMPARISON OF RESULTS WITH NBS [1] DATA 

EXHIBIT 5.4 - SPECIFIC HEAT OF DRY AIR 

Temperature 
Range Pressure 

From To 1 atm 10 atm 40 atm 

deg K deg K Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

Avg 
Error 

Max 
Error 

180 250 0.04% 0.11% 0.35% 1.04% 1.05% 3.17% 

260 300 0.00% 0.00% 0.05% 0.06% 0.29% 0.38% 

310 350 0.00% 0.01% 0.02% 0.03% 0.10% 0.17% 

360 400 0.00% 0.00% 0.00% 0.01% 0.02% 0.03% 

410 500 0.00% 0.00% 0.01% 0.01% 0.04% 0.06% 

510 600 0.00% 0.00% 0.01% 0.01% 0.03% 0.04% 

610 700 0.00% 0.00% 0.00% 0.01% 0.01% 0.02% 

710 800 0.00% 0.00% 0.00% 0.02% 0.01% 0.04% 

850 1450 * 0.47% * 0.07% * 0.47% * 1.37% * 0.49% * 1.40% 

1500 2000 ** ** ** ** ** ** 

Notes: *, ** - Questionable reference data. 
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COMPARISON OF RESULTS WITH ASHRAE [9] & NBS [1] 
EXHIBIT 5.5 - SPECIFIC VOLUME 

Temp 
º F 

Dry Air at 1 atm 
ft3/lbm 

  Saturated Moist Air at 1 atm 
ft3/lbm of Dry Air 

NBS @Air ASHRAE @Air ASHRAE 

-80 9.556  9.554    9.553  9.554 9.553 

-70 9.809  9.807    9.807  9.807 9.807 

-60 10.062  10.061  10.060  10.061 10.06 

-50 10.316  10.314  10.313  10.314 10.314 

-40 10.569  10.567  10.567  10.568 10.568 

-30 10.822  10.820  10.820  10.823 10.822 

-20 11.075  11.073  11.073  11.078 11.078 

-10 11.328  11.326  11.326  11.335 11.335 

0 11.581  11.579  11.579  11.594 11.594 

10 11.834  11.832  11.832  11.857 11.857 

20 12.087  12.085  12.085  12.127 12.127 

30 12.340  12.338  12.338  12.406 12.406 

40 12.592  12.591  12.591  12.696 12.696 

50 12.845  12.844  12.844  13.001 13.001 

60 13.098  13.096  13.096  13.329 13.329 

70 13.351  13.349  13.349  13.688 13.688 

80 13.604  13.602  13.602  14.089 14.089 

90 13.856  13.854  13.855  14.547 14.547 

100 14.109  14.107  14.107  15.083 15.084 

110 14.361  14.360  14.360  15.727 15.727 

120 14.614  14.612  14.613  16.519 16.519 

130 14.867  14.865  14.865  17.520 17.52 

140 15.119  15.118  15.118  18.826 18.825 

150 15.372  15.370  15.370  20.589 20.589 

160 15.624  15.623  15.623  23.082 23.082 

170 15.877  15.875  15.875  26.835 26.834 

180 16.130  16.128  16.128  33.037 33.037 

190 16.382  16.380  16.381  45.043 45.042 

200 16.635  16.633  16.633  77.426 77.426 
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COMPARISON OF RESULTS WITH ASHRAE [9] & NBS [1] 
EXHIBIT 5.6 - ENTHALPY 

Temp 
º F 

Dry Air  at 1 atm 
Btu/lbm 

  Saturated Moist Air at 1 atm 
Btu/lbm of Dry Air 

NBS @Air ASHRAE @Air ASHRAE 

-80 -19.217 -19.218 -19.221 -19.213 -19.215 

-70 -16.815 -16.814 -16.806 -16.803 -16.817 

-60 -14.412 -14.410 -14.414 -14.388 -14.392 

-50 -12.009 -12.007 -12.011 -11.964 -11.968 

-40 -9.606 -9.605 -9.609 -9.522 -9.526 

-30 -7.203 -7.203 -7.206 -7.050 -7.053 

-20 -4.802 -4.802 -4.804 -4.525 -4.527 

-10 -2.401 -2.401 -2.402 -1.914 -1.915 

0 0.000 0.000 0.000 0.836 0.835 

10 2.401 2.401 2.402 3.803 3.804 

20 4.802 4.803 4.804 7.106 7.107 

30 7.203 7.205 7.206 10.916 10.917 

40 9.606 9.606 9.609 15.233 15.233 

50 12.009 12.009 12.012 20.307 20.306 

60 14.412 14.412 14.415 26.470 26.467 

70 16.815 16.815 16.818 34.101 34.097 

80 19.218 19.218 19.222 43.706 43.701 

90 21.622 21.622 21.626 55.959 55.951 

100 24.027 24.027 24.031 71.770 71.761 

110 26.432 26.431 26.436 92.397 92.386 

120 28.837 28.836 28.842 119.628 119.612 

130 31.244 31.244 31.249 156.095 156.076 

140 33.652 33.652 33.656 205.849 205.824 

150 36.060 36.059 36.064 275.516 275.49 

160 38.469 38.468 38.474 376.760 376.737 

170 40.878 40.877 40.884 532.293 532.256 

180 43.289 43.288 43.295 793.156 793.166 

190 45.703 45.700 45.707 1303.287 1303.321 

200 48.120 48.114 48.121 2688.073 2688.205 
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COMPARISON OF RESULTS WITH ASHRAE [9] & NBS [1] 
EXHIBIT 5.7 – ENTROPY 

Temp 
º F 

Dry Air at 1 atm 
Btu/lbm/ºF 

  Saturated Moist Airat 1 atm 
Btu/lbm/ºF of Dry Air 

NBS @Air ASHRAE @Air ASHRAE 

-80 -0.04589 -0.04593 -0.04594 -0.04592 -0.04592 

-70 -0.03964 -0.03968 -0.03969 -0.03965 -0.03966 

-60 -0.03357 -0.03359 -0.03360 -0.03354 -0.03354 

-50 -0.02766 -0.02766 -0.02766 -0.02754 -0.02755 

-40 -0.02189 -0.02186 -0.02187 -0.02165 -0.02166 

-30 -0.01623 -0.01621 -0.01621 -0.01583 -0.01583 

-20 -0.01071 -0.01068 -0.01069 -0.01001 -0.01002 

-10 -0.00531 -0.00528 -0.00528 -0.00414 -0.00414 

0 0.00000 0.00000 0.00000 0.00192 0.00192 

10 0.00519 0.00517 0.00517 0.00832 0.00832 

20 0.01024 0.01023 0.01023 0.01528 0.01528 

30 0.01518 0.01518 0.01519 0.02315 0.02315 

40 0.02002 0.02004 0.02004 0.03187 0.03187 

50 0.02478 0.02480 0.02480 0.04192 0.04192 

60 0.02945 0.02946 0.02947 0.05389 0.05389 

70 0.03403 0.03405 0.03406 0.06845 0.06844 

80 0.03853 0.03854 0.03855 0.08643 0.08642 

90 0.04295 0.04296 0.04297 0.10896 0.10895 

100 0.04729 0.04729 0.04730 0.13754 0.13752 

110 0.05157 0.05155 0.05156 0.17421 0.17418 

120 0.05577 0.05573 0.05575 0.22183 0.22180 

130 0.05989 0.05985 0.05986 0.28460 0.28457 

140 0.06394 0.06390 0.06391 0.36894 0.36890 

150 0.06793 0.06788 0.06790 0.48529 0.48524 

160 0.07185 0.07180 0.07181 0.65193 0.65188 

170 0.07572 0.07566 0.07567 0.90433 0.90425 

180 0.07951 0.07946 0.07947 1.32184 1.32183 

190 0.08325 0.08320 0.08321 2.12731 2.12733 

200 0.08692 0.08689 0.08690 4.28462 4.28477 
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COMPARISON OF RESULTS WITH ASHRAE [9] 
EXHIBIT 5.8 - ENHANCEMENT FACTORS 
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COMPARISON OF RESULTS WITH ASHRAE [9] 
EXHIBIT 5.9 - SATURATED HUMIDITY RATIO 

Temp 
º F 

  Saturated Moist Air at 1 atm 

ASHRAE @Air Difference % Error 

-80 0.0000049 0.0000049 0.0000000  0.00% 

-70 0.0000104 0.0000104 0.0000000  0.00% 

-60 0.0000212 0.0000212 0.0000000  0.00% 

-50 0.0000416 0.0000417 0.0000001  0.24% 

-40 0.0000793 0.0000793 0.0000000  0.00% 

-30 0.0001465 0.0001466 0.0000001  0.07% 

-20 0.0002632 0.0002633 0.0000001  0.04% 

-10 0.0004608 0.0004610 0.0000002  0.04% 

0 0.0007875 0.0007879 0.0000004  0.05% 

10 0.0013158 0.0013165 0.0000007  0.05% 

20 0.0021531 0.0021541 0.0000010  0.05% 

30 0.0034552 0.0034568 0.0000016  0.05% 

40 0.005216 0.005219 0.000003  0.05% 

50 0.007661 0.007666 0.000005  0.06% 

60 0.011087 0.011094 0.000007  0.06% 

70 0.015832 0.015841 0.000009  0.06% 

80 0.022340 0.022352 0.000012  0.05% 

90 0.031203 0.031218 0.000015  0.05% 

100 0.043219 0.043238 0.000019  0.04% 

110 0.059486 0.059510 0.000024  0.04% 

120 0.081560 0.081592 0.000032  0.04% 

130 0.111738 0.111775 0.000037  0.03% 

140 0.153538 0.153585 0.000047  0.03% 

150 0.21273 0.21279 0.00006  0.03% 

160 0.29945 0.29951 0.00006  0.02% 

170 0.43343 0.43352 0.00009  0.02% 

180 0.65911 0.65917 0.00006  0.01% 

190 1.10154 1.10162 0.00008  0.01% 

200 2.30454 2.30460 0.00006 0.00% 
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APPENDIX  
@Air ERROR CODES 

If an error is encountered by a TAIR32.DLL or TAIR64.DLL function during calculation of an air 
property, the function returns a negative value (-1000 or lower).  This Appendix presents the 
error numbers together with an explanation of each possible error condition.  The header file 
AIRERR.H defines mnemonic constants for the error codes.  The mnemonics are listed below 
also. 

The error codes listed below are accessible only from Windows programming languages such 
as Visual C, Quick C or Visual BASIC.  The interfaces provided for Excel, 1-2-3 and Mathcad 
intercept these error numbers and return appropriate error values.  This is done to avoid 
inadvertent use of an error value in a cell equation.  DeskTop Air also intercepts these codes 
and displays appropriate messages. 

ERR_NOSAT(-1100): No Saturation 

Saturated conditions are not defined for the calculated state point. 

ERR_THIGH(-2000): Temperature Too High 
ERR_TLOW(-2100): Temperature Too Low 
ERR_WBHIGH(-2200): Wet Bulb Temperature Too High 
ERR_WBLOW(-2300): Wet Bulb Temperature Too Low 
ERR_DPHIGH(-2400): Dew Point Temperature Too High 
ERR_DPLOW(-2500): Dew Point Temperature Too Low 

@AIR will accept a maximum temperature of 2000 deg K and a minimum temperature of 
180 deg K. Any attempt to calculate air properties at temperatures outside of this range will  
return one of these error numbers. 

ERR_PHIGH(-3000): Pressure Too High 
ERR_PLOW(-3100): Pressure Too Low 
 

@AIR will accept a maximum pressure of 50 bar and a minimum pressure of 0 bar.  Any 
attempt to calculate air properties at pressures outside of this range will return one of these 
error numbers. 

ERR_VOLHIGH(-4000):  Volume Too High 
ERR_VOLLOW(-4100):  Volume Too Low 

 
Any attempt to calculate air properties at volumes that correspond to temperatures and 
pressures outside of the ranges described above will return one of these error numbers. 
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ERR_RHIGH(-5000): Relative Humidity Too High 
ERR_RLOW(-5100): Relative Humidity Too Low 
ERR_UHIGH(-6000): Degree of Saturation Too High 
ERR_ULOW(-6100): Degree of Saturation Too Low 

 
Relative Humidity and Degree of Saturation can have values ranging from 0 to 1.  Any attempt 
to calculate air properties at a relative humidity or degree of saturation outside of this range 
above will return one of these error numbers. 

ERR_WHIGH(-7000): Humidity Ratio Too High 
 

Any attempt to calculate air properties at a humidity ratio that is greater than the saturated 
humidity ratio for the specified pressure and temperature will return this error number. 

ERR_WLOW(-7100): Humidity Ratio Too Low 
 

Any attempt to calculate air properties at a humidity ratio that is less than 0 will return this  
error number. 

ERR_XHIGH(-7300): Mole or Mass Fraction Too High 
 

Mole or Mass fraction of water vapor cannot be greater than 1.  Any attempt to calculate an air 
property with a mole or mass fraction greater than 1.0 will return this error number. 

ERR_HHIGH(-9000):  Enthalpy Too High 
ERR_HLOW(-9100):  Enthalpy Too Low 
ERR_SHIGH(-9200):  Entropy Too High 
ERR_SLOW(-9300):  Entropy Too Low 

 
Any attempt to calculate air properties at enthalpy or entropy values outside of the program 
range will return one of these error numbers. 
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